電子檔案規格、轉檔與上傳作業說明
Guide of ETDS File Format and Conversion and ETDS Service
Workflow
Content

I. Guide of ETDS File Format .................................................................................................................. 4
   File Format ........................................................................................................................................ 4

II. MS Word File Format ........................................................................................................................ 5
   Recommended version .................................................................................................................... 5
   Font settings ..................................................................................................................................... 5
   Picture Format .................................................................................................................................. 5
   The use of special symbols ................................................................................................................ 5

III. Notes for before file conversion to PDF ....................................................................................... 6
   Anti-virus .......................................................................................................................................... 6
   scanning ........................................................................................................................................... 6
   File merger ....................................................................................................................................... 6
   Confirm your thesis/dissertation file ............................................................................................... 6
   Special treatments ............................................................................................................................ 6

IV. Page layout after files being combined ......................................................................................... 7
   Page layout ....................................................................................................................................... 7
   steps ................................................................................................................................................ 7

V. File converting process .................................................................................................................... 9
   Add the watermark in PDF ............................................................................................................. 12
   Acrobat Distiller 6.0 ....................................................................................................................... 9
   Acrobat 6.0 ..................................................................................................................................... 133
   Acrobat 7.0 ..................................................................................................................................... 16
   Special treatments ............................................................................................................................. 166
   File Naming .................................................................................................................................... 17
   Inspection items before uploading files .......................................................................................... 18

VI. Upload File ..................................................................................................................................... 19
Login in the E-Theses & Dissertations Service ...................................................... 19
Basic Information of thesis / dissertation ............................................................ 20
Set up committee members .................................................................................. 21
Upload Thesis/ Dissertation .................................................................................. 22
Authorization Submit for process ........................................................................ 27
Audit notice ............................................................................................................ 25
## Guide of ETDS File Format

<table>
<thead>
<tr>
<th>File Format</th>
<th>Please upload PDF file. If you have conversion problem, please re-upload MS Word file or PostScript (.ps) file.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Using MS Word is recommended to write theses; use Acrobat 5.0 or higher to convert the theses into PDF files.</td>
</tr>
<tr>
<td></td>
<td>The NTU watermark is needed to be attached to the E-theses. (If the thesis is written with MS Word, the watermark is needed to be attached; if it’s written with Tex / Latex then the watermark is not needed)</td>
</tr>
<tr>
<td></td>
<td>Please set up content protection measures for the PDF files to prevent copying and pasting</td>
</tr>
<tr>
<td></td>
<td>The PDF content can have word search and be embedded with Chinese fonts.</td>
</tr>
</tbody>
</table>
## II. MS Word File Format

<table>
<thead>
<tr>
<th>Recommended version</th>
<th>It is recommended that your thesis be written with Word; do not change the paper’s “layout setting” (do not change the default) to ensure correct PDF file converting.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font settings</td>
<td>The following fonts are recommended to be used to avoid the words not being properly presented during PDF file converting.</td>
</tr>
<tr>
<td></td>
<td>- Chinese font: 標楷體，細明體，新細明體</td>
</tr>
<tr>
<td></td>
<td>- English font: Times New Roman， Arial， Arial Black， Arial Narrow， Bookman Old Style， Comic Sans Ms， Courier New</td>
</tr>
<tr>
<td></td>
<td>- Just a reminder, if your thesis is not written with the above-mentioned fonts, then your e-thesis may not be able to provide the full-text search service.</td>
</tr>
<tr>
<td>Picture Format</td>
<td>To avoid errors during file conversion process, please use .gif and .jpg picture format.</td>
</tr>
<tr>
<td></td>
<td>- Try not to use .bmp format, if there are other picture formats, please convert them into .gif and .jpg format to avoid the file being too big.</td>
</tr>
<tr>
<td>The use of special symbols</td>
<td>If your thesis requires having special symbols inserted, please be sure to use the Symbol font.</td>
</tr>
<tr>
<td></td>
<td>- If the symbol that you need does not exist in the Symbol font, it is recommended to use the Microsoft formula editor in Word for editing.</td>
</tr>
</tbody>
</table>
III. Notes for before file conversion to PDF

<table>
<thead>
<tr>
<th>Anti-virus scanning</th>
<th>Please use anti-virus software to check if there are viruses in the original thesis, and after scanning, the following operating can be proceeded.</th>
</tr>
</thead>
<tbody>
<tr>
<td>File merger</td>
<td>Please convert the entire thesis as one file.</td>
</tr>
<tr>
<td></td>
<td>If the thesis document has many Word files, please combine these Word files into one file and number the pages before PDF file conversion.</td>
</tr>
<tr>
<td></td>
<td>Please combine cover, directory, chapters, pictures, and references into one file for file conversion.</td>
</tr>
<tr>
<td>Confirm your thesis/dissertation file</td>
<td>Please make sure that the e-thesis contains all the paper thesis’ contents, including title page, thank notes or foreword, Chinese and English Abstract, charts and index, the paper, reference, and appendix, and the content and page order of the e-thesis please refer to the written paper.</td>
</tr>
<tr>
<td>Special treatments</td>
<td>If a defined program is used to create the characters, the C: \ windows \ eudc.euf and eudc.tte in the computer can be copied to your computer that is going to convert files, and after pasting on the computer’s eudc.euf and eudc.tte, the file can be converted.</td>
</tr>
</tbody>
</table>
IV. Page layout after files being combined

- After the files are combined, please adjust the page orders to match the paper thesis, if there are any questions about page layouts, please follow the following steps to process:

1. Please go the last page’s last line of the page going to be separated
   (For example: Page 11 is the text, please use Arabic numerals coding, and the first 10 pages will be using Roman numerals coding, and please go to the last line of page 10)
   
   Select toolbar **Insert** → **Break**

2. Select **sub-section symbol type** → **start from the next page**

3. At this point the article had been set to different sections, click
   
   **Insert** → **Page** → **Format**
(4) Click **format**, the following screen will show:

Then select the “format” that the page number is going to be shown, and then select “page coding method” to edit your e-thesis’ page code.

Just a reminder, the e-thesis page code shall match the paper thesis page code!

(5) If the article is required to be divided into several paragraphs, the above-mentioned steps can be repeated to edit the page number.
## E-thesis file conversion and enhancing thesis protection measures

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>V. File converting process</strong></td>
<td></td>
</tr>
<tr>
<td>(1)</td>
<td>Process PDF file transferring in the computer classroom of the school computer center, the main library, and the Law and Social Sciences Library, or the medical Library.</td>
</tr>
<tr>
<td>(2)</td>
<td>Please use Acrobat 6.0 or higher to convert the theses into PDF files.</td>
</tr>
<tr>
<td>(3)</td>
<td>Do not transfer files using the express button of “convert to Adobe PDF” on the top-right of Word to avoid errors while loading PDF files to the database.</td>
</tr>
</tbody>
</table>

## Convert PS file to the PDF file that prevents copying / pasting

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>General common documents editing files, such as: text file (.txt), Microsoft Word file (.doc), etc format usually can be converted into PDF files easily. The PostScript (.Ps) format frequently uses Science and engineering departments required to converted to PDF files through Acrobat Distiller, and before converting the PS file, the PDF protection can be set on the Acrobat Distiller to ensure that the converted PDF files have the protection measures (Anti-copy / paste), please see the following icon description:</td>
</tr>
</tbody>
</table>

### Acrobat Distiller 6.0

- Open Acrobat Distiller 6.0, "Adobe PDF settings", select "Standard", and then select **Settings**

![Acrobat Distiller 6.0](image)
In **Setting**, pull-down the menu, at the end select **Protection**.

After clicking on protection:

(i) Do not check **request password to open the documents**

(ii) Please check use password restrictions on the settings of printing, editing and prevention for the documents, and set up your personal **password**.

(iii) In the **Print** menu, select **high-resolution**

(iv) In the **allow changes** menu, select **no**

(v) Do not check **activate copying text, images and other contents**

After checking **OK**, convert PS file to PDF file.
• Click **OK** an authority to confirm the password window will show, please enter the password you set before again, and then click **OK**

![Password Confirmation](image)

• Save the prepared to be converted PS file on the desktop

• Pull the PS file to the Acrobat Distiller 6.0 window, at this time, it will bring up the 'security' message box, select **maintain**.

![Acrobat Distiller](image)

• Acrobat Distiller 6.0 will automatically convert files to PDF files, and save them on the desktop with the same names, and the file converting and protection are completed at the same time.
1. Please download the『NTU watermark file』into your local computer from `http://etds.lib.ntu.edu.tw/files/watermark.jpg`.

(In order to maintain the consistency of paper quality, please follow our instructions to adjust the size and location of watermark!)

2. Open your PDF File and choose Document→Watermark→Add

3. (1) Select the NTU watermark from File, and (2) Absolute Scale turn to 50%. (3) Change Opacity to 50%, and (4) the Location should be Appear on top of page. (5) Finally, the position of Vertical Distance is 2.5 Centimeters from Top, and Horizontal Distance is 2.5 Centimeters from Right.

4. Save all these changes.
If you use the most common MS Word to write your thesis, you can go through Adobe Acrobat to convert MS Word files to PDF files, and add prevention of copying/pasting to your PDF files. Due to different versions of Adobe Acrobat, the converted name may not be the same, please follow the instructions for file conversion.

<table>
<thead>
<tr>
<th>Acrobat 6.0</th>
<th>Acrobat 7.0</th>
</tr>
</thead>
</table>

### Acrobat 6.0

- Open your e-thesis MS Word file in a computer with Acrobat 6.0
- Select: File → Print
- Select the printer: Adobe PDF
- Click Content → switch to Adobe PDF Settings
- Select Adobe PDF protection menu: select reconfirm the protection of all the work, and click Edit
Click on **Edit**, the **Adobe PDF protection** window will appear:

(i) **Do not check** request password to open the documents

(ii) **Please check** use password restrictions on the settings of printing, editing and prevention for the documents, and set up your personal **password**

(iii) In the **Print** menu, select **high-resolution**

(iv) In the **allow changes** menu, select **no**

(v) **Do not check** activate copying text, images and other contents
After checking, click **OK**, go back to Adobe PDF settings, then check **do not send fonts to Adobe PDF** and then press **OK**.

After all the moves are set, continue to click on two **OK**, the saving location for the converted PDF file, after the location is selected, then click “OK” to immediately process file converting, when the file is successfully converted, it will automatically open the PDF file that cannot be copying/pasting.
Acrobat 7.0

- Open your e-thesis MS Word file in a computer with Acrobat 7.0
- Select: **File → Print**

![Print options in Acrobat 7.0](image)

- Select the printer: Adobe PDF
- Click **Content** → switch to **Adobe PDF Settings**
- Select **Adobe PDF protection** menu: select reconfirm the protection of all the work, and click **Edit**

The follow up prevention moves are the same as the method of Acrobat 6.0.

**Special treatments**

- If a defined program is used to create the characters, the C:\windows\eudc.euf and eudc.tte in the computer can be copied to your computer that is going to convert files, and after pasting on the computer’s eudc.euf and eudc.tte, the file can be converted.
Do not use 'Chinese' file names, file names cannot contain full-text spaces, or some special characters, such as: ~ . * / \ ( ) + [ ] {}, otherwise errors will appear when loading to the database.

Save PDF files on the desktop to ensure whether PDF files can be opened, if it can be opened, then the conversion procedure is completed.
<table>
<thead>
<tr>
<th>Inspection items before uploading files</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) After the successfully converted PDF file is opened, please check if your PDF file matches your paper form. The inspection items:</td>
</tr>
<tr>
<td>(i) Whether to add more PDF protection?</td>
</tr>
<tr>
<td>(ii) When adding more protection, do not check “use password to open PDF” and “no printing” these two options</td>
</tr>
<tr>
<td>(iii) Whether the PDF file can be opened normally?</td>
</tr>
<tr>
<td>(iv) Whether to add the watermark?</td>
</tr>
<tr>
<td>(v) Whether the entire thesis is converted into a PDF file?</td>
</tr>
<tr>
<td>(vi) Check if the total page amount and the starting and ending page number in each chapter of the PDF file match the paper thesis?</td>
</tr>
<tr>
<td>(vii) Whether the text content of the PDF file has ASCII?</td>
</tr>
<tr>
<td>(viii) Whether the font of the PDF file match the paper thesis font?</td>
</tr>
<tr>
<td>(2) If you have any problems, please contact us:</td>
</tr>
<tr>
<td>Main Library: 02-33662366 or E-mail <a href="mailto:ntuetds@ntu.edu.tw">ntuetds@ntu.edu.tw</a></td>
</tr>
<tr>
<td>Law Library: 02-23519641#313 or E-mail <a href="mailto:lawlib@ntu.edu.tw">lawlib@ntu.edu.tw</a></td>
</tr>
<tr>
<td>Medical Library: 02-23123456 # 88152 or E-mail <a href="mailto:medlib@ntu.edu.tw">medlib@ntu.edu.tw</a></td>
</tr>
</tbody>
</table>
VI. Upload File

- Check your ComputerCenter e-mail address and Password (PIN)

Ensure the personal ID and password given by the school computer center before logging in, if the ID/password is forgotten, please contact the computer center. TEL: 02-33665022

- Login in the E-Theses & Dissertations Service:

  From: Login from the school library webpage, or type in the web site address directly
  http://etds.lib.ntu.edu.tw/etdsystem/submit/submitLogin

  Please enter your ComputerCenter e-mail address and Password (PIN), then click Login

Login in the E-Theses & Dissertations Service

From:
- Login from the school library webpage, or type in the web site address directly
  http://etds.lib.ntu.edu.tw/etdsystem/submit/submitLogin

Please enter your ComputerCenter e-mail address and Password (PIN), then click Login
Please provide the basic Information of thesis / dissertation

If you find that your thesis has insufficient information, click on “save temperately”, the system will keep the information you have entered, please remember to return within 30 days to continue to conduct operations to avoid the information being deleted!

Enter completed, click Next
Set up committee members

- Please provide the information of your committee members (contain Advisor/Advising professor)

- The system default has set three Committee Members’ information, if there are more than three Committee Members, click Add Committee Members to add more information.

- If the title of the committee member is not instructing professor or commissioner, please email us, we will add the committee member’s title for you.

- The Chinese name and the title of the commissioner must be filled.

- After completing the above information, please click “next”
Please Upload Thesis/Dissertation file:

(1) Please upload all the chapters within one single file.

(2) Please upload PDF files, click browse, select the right file, and then click upload. After the file is uploaded, the system will automatically change its name.

(3) If the original format of your thesis/dissertation is PostScript(.ps), you can convert PostScript file to PDF file by Acrobat Distiller and then upload it

(4) If you have difficulties in PDF converting, then you could upload the MS word file by the field named 'Upload the MS word file.' Or, you could upload your PostScript file by the field named 'Upload the PostScript (.ps) file'

(5) If you have any problems, please contact us:

Main Library: 02-33662366 or E-mail
ntuetds@ntu.edu.tw

Law Library: 02-23519641#313 or E-mail
lawlib@ntu.edu.tw

Medical Library: 02-23123456 # 88152 or E-mail
medlib@ntu.edu.tw
Please Choice the Authorization

Would you agree to authorize your thesis/dissertation with royalty fee?

i. Yes, I agree to authorize my thesis/dissertation with royalty fee
   · Please donate my royalty fee to school library as a development fund (default).
   · Yes, I agree to authorize my thesis/dissertation with royalty fee. Please contact me for the royalty fee redeem.

ii. Yes, I agree to authorize my thesis/dissertation without royalty fee

iii. No, I don't agree

agree to authorize your thesis/dissertation with royalty fee to myself: Please provide your contact information for the notification of your royalty fee redeem.

- Your Frequently Used E-Mail
- Contact Phone Number
- Contact Address

Please note that if your contact information is changed, please contact your library for the update. If the royalty fee is not redeemed for more than one year, it will automatically donate to "School Development Fund" for library use

Agree to authorize my thesis/dissertation with royalty fee, Please choose the open policy for you thesis/dissertation

Submit for process
After all the above-mentioned processes, please select “submit auditing immediately”

If you find that your thesis has insufficient information, click on “save temperately”, the system will keep the information you have entered, please remember to return within 30 days to continue to conduct operations to avoid the information being deleted. Thanks for your assistance and help!

Click complete, when the window of “your thesis has been submitted for auditing…”, it means you have successfully submitted your thesis for auditing!

Thesis/dissertation is submitted and it would take 2 working days for the process. Upon its done, we will notify you with the result of submission via E-Mail. Please kindly contact us if you still don't get any notification from us after two days upon your submission day. Or you can login in E-Theses & Dissertations Service and search the result of submission.

TEL: 02-33662366
After you receive an audit notice:

- The pending time is about 2-3 days, if you haven’t received a notice more than 3 days, please call us or log in to the system to check!

- Approved
  
  Congratulation! Your submission of thesis/dissertation is approved!

  If you would like to authorize your thesis/dissertation to CETD, please print out the authorization agreement and sign it; then hand-in the signed agreement and printed thesis/dissertation to library for gradation process.

- Disapproved

  Sorry! The thesis/dissertation submission of you student is disapproved
  
  The reason to disapprove: Can not open the uploaded PDF file

  Please review your thesis/dissertation and then submit after correction!

  Thanks for your assistance and help

- To ensure that your thesis can be approved, please ensure the PDF file content quality! If you have any problems, please contact us:

  Main Library： 02-33662366 or E-mail

  ntuetds@ntu.edu.tw

  Law Library： 02-23519641#313 or E-mail

  lawlib@ntu.edu.tw

  Medical Library： 02-23123456 # 88152 or E-mail

  medlib@ntu.edu.tw